
Introduction

Welcome	to	the	reference	documentation	for	LT10.	Here	you	can	find	details
about	features	and	utilities	of	this	software.	If	you're	new	to	LT10	start	with
Getting	started	with	LT10.

Feel	free	in	using	left	contents	panel	and	links	at	the	top	of	each	page	to
navigate	to	desired	subjects.

LT10

Modern	operating	systems	besides	of	their	many	advantages	raise
compatibility	issues	for	programs	compiled	in	former	languages.	It	is	one	of	the
reasons	why	the	new	program	for	numerical	analysis	of	positron	annihilation
lifetime	spectra	was	built.	As	it	is	the	continuation	of	well	known	LT	series	it
inherits	most	of	the	features	available	and	solutions	used	in	LT	(numerical
routines	and	analysis	logic).	Like	in	previous	versions,	operating	on	series	of
spectra	makes	possible	to	correlate	selected	parameters	belonging	to	different
spectra	of	a	series.	Despite	of	features	already	implemented	earlier,	designing
new	version	was	perfect	opportunity	to	include	features	yet	unavailable	in	other
versions	of	the	program.	Moreover,	the	completely	new	user	interface	was
designed	to	make	those	features	easy	to	use.	New	structure	of	the	program
supported	with	checked	logic	makes	the	computer	analysis	flexible	and	versatile.



Requirements

Since	LT10,	requires	Microsoft	.NET	Framework	3.5	to	work,	requirements
for	this	framework	applies	to	LT10	also.	(Below	are	presented	requirements	for
framework	available	on	Microsoft	website:
http://download.microsoft.com/download/9/a/e/9ae0f6cc-7032-408e-9ca7-
989f9e4af4ec/dotNetReadMe.htm)

Supported	Architectures

x86
x64
ia64	(Windows	Server	2008)

Supported	Operating	Systems

Microsoft	Windows	XP
Microsoft	Windows	Server	2003
Windows	Vista
Windows	Server	2008
Windows	7

Hardware	Requirements

Minimum
400	MHz	CPU,	96	MB	RAM,	800x600	256-color	display

Recommended
1.0	GHz	or	higher	CPU,	256	MB	or	more	RAM,	1024x768	high-color	32-
bit	display

Up	to	500	MB	of	hard	disk	space	may	be	required

Framework

Required	framework	is	available	to	download	at	this	address:	
http://msdn.microsoft.com/en-us/netframework/aa569263.aspx

http://msdn.microsoft.com/en-us/netframework/aa569263.aspx
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Getting	started	with	LT10

Introduction

Once	you've	downloaded	and	installed	LT10	you	have	are	able	to	run
program.	Below	you	can	see	the	main	window	which	appears	after	program
execution.

This	window	is	the	desktop	of	the	LT10	program	which	holds	opened	projects.
You	are	allowed	to	open	multiple	projects	as	if	they	were	a	documents	in	MDI
application.	To	switch	between	them	use	either	Windows	menu	or	keyboard
shortcut	Ctrl+Tab.

New	Project

In	order	to	work	with	spectra	series	you	have	to	either	open	existing	project	or



create	the	new	one.	This	section	presents	wizard	which	creates	new	project.

To	create	a	new	project	choose	File	->	New.	All	you	have	to	do	is	to	choose
theoretical	model	and	spectra	of	interest.	It	is	done	by	clicking	proper	button	in
documents	tree	in	New	Project	dialog	(see	figure	below).

Although,	project	will	contain	one	document	by	default,	with	chosen
theoretical	model	and	spectra,	document	count	may	be	changed	with
Add/Remove	buttons	in	New	Project	dialog.	When	working	with	multiple
documents	with	different	theoretical	models	and	spectra	it	is	adviced	to	name
each	document	by	clicking	default	document	name.

note
Both	theoretical	model	and	spectra	of	each	document,	although



chosen	while	creating	new	project,	may	be	modified	after	project	is
created	in	project's	Propeties.	New	documents	may	be	added	as
well.

Once	project	is	created,	theoretical	function	paramter	must	be	set	to	its	initial
value,	as	close	to	the	real	one	as	possible.	The	more	exact	values	is	provided	the
more	reliable	analysis	result	can	be	expected.	
Parameters	are	logically	grouped	in	four	groups:

sample	parameters	(dependent	on	theoretical	model)
source	parameters	(intensities	and	lifetimes	of	number	of	components)
prompt	parameters	(resolution	curve	parameters)
range	parameters	(analysis	range,	zero	channel	and	background)

Some	of	them	(like	range	and	prompt	parameters)	already	have	default	initial
value,	other	(like	sample	and	source	parameters)	should	be	provided	manually.
Also	component	count	(if	possible)	should	be	manually	adjusted	like	in	sample
or	source	case	with	special	spin	edit	below	proper	parameters	grid.



note
Some	of	theoretical	models	like	Trapping	Models	have	fixed
component	count	to	1.	In	those	cases	component	count	cannot	be
changed	and	there	is	no	spin	edit	below	parameters	grid.

Fitting	theoretical	curves	to	the	experimental	data

To	run	calculations,	there	must	be	one	of	the	parameters	grid	displayed,	since
the	parameters	grid	defines	which	spectra	will	be	fitted.

note
Displayed	parameters	grid	doesn't	determine	fitting	parameter	set
but	spectra	which	will	be	fitted.	For	example,	if	displayed
parameters	grid	is	sample,	other	parameters	will	be	fitted	as	well,
as	long	as	spectrum	included	in	sample	group	is	also	included	in



other	parameter	groups.

note
Attempting	to	run	calculations	when	displaying	other	page	than
that	holding	parameters	grid	(eg.	Search)	results	in	showing
message	box	instructing	to	choose	one	of	the	parameters	grid.

Calculations	may	be	run	in	following	ways:

1.	 calculations	for	first	spectrum	in	currently	displayed	parameters	grid	-	Fit
first	spectrum

2.	 calculations	for	all	spectra	in	currently	displayed	parameters	grid	-	Fit
series	of	spectra

3.	 calculations	for	custom	spectrum	in	currently	displayed	parameters	grid	-
Fit	[spectrum_name]	in	parameters	grid's	context	menu

note
While	running	calculations	for	either	first	spectrum	or	for	all
spectra	in	currently	displayed	series	can	be	achived	by	using

calculations	toolbar	

(or	Project	menu),	fitting	custom	spectrum	can	be	done	only
through	parameters	grid's	context	menu.

Every	time	calculations	is	about	to	run,	Search	tab	of	project	is	activated	to
allow	user	to	follow	calculations	progress.

note
User	may	disable	automatic	switching	to	Search	tab	of	project	by
deselecting	Switch	to	Search	tab	after	calculations	run	check	box
in	General	tab	of	Tools	->	Options	dialog.

Finished	calculations,	as	well	as	each	calculations	progress,	are	prompted	by
proper	entry	in	Events	box	in	Search	tab.	Moreover,	if	calculations	were	run	for
single	spectrum,	special	fit	window	appears	with	displayed	fit	for	chosen
spectrum,	when	calculations	are	over.	If	those	fits	are	dissatisfactory,
calculations	may	be	repeated	by	clicking	button	Fit	again	in	this	window.



See	also Project Parameters	Grid Parameters	Status



Bindings

There	are	two	kind	of	bindings	available	in	LT10:

Interodument	parameter	(Create	interdocument	value	button)
Shared	group	(Join	document	groups	button)

Both	binding	can	be	created	in	Project	properties	->	Bindings	view.

note



To	distinguish	type	of	binding	in	bindings	view,	both	binding	types
are	marked	with	different	colors.



See	also Project Theoretical	model Parameters	Grid



Document

Document	in	LT10	is	a	spectra	holder	with	binded	theoretical	model.

Each	document	has	its	own	tab	page	in	owning	project's	form.	User	interface
of	document	is	also	tab	page	control,	which	contain	as	many	tab	pages	holding
parameter	grids	as	many	parameter	groups	are	defined	in	theoretical	model.



See	also Parameters	Grid



Fit	window

Tool	which	shows	fit	quality.	Every	time	calculations	for	first	spectra	in	each
document	ends	with	showing	this	window.	Moreover,	after	series	calculations
you	may	see	fit	quality	of	any	spectrum	in	series	by	choosing	parameters	grid's
context	menu	->	Show	spectrum	fit.	The	top	chart	contains	such	series	as

Experimental	spectrum
Theoretical	curve
Curves	representing	each	component	in	each	group



The	bottom	chart	in	fit	window	shows	fit	quality.	The	more	even	graph	the
better	fit.	If	fit	is	not	satisfying	try	clicking	"Fit	again".

Values	in	bottom	chart	are	calculated	with	equation:

	where
i	-	channel	number
E[i]	-	value	of	experimental	spectrum	at	channel	i
T[i]	-	value	of	theoretical	curve	at	channel	i
D[i]	-	difference	between	theory	and	experiment	at	channel	i

Good	fit

Bad	fit

It	is	possible	to	change	the	color	of	visible	components	in	the	top	chart	or
even	hide	some	of	the	components.	To	do	that	expand	series	list	by	clicking
Series	button	on	the	top	toolbar



Charts	may	be	saved	to	either	bitmap	 	(*.bmp	file	with	top	and	bottom	charts

with	selected	series)	or	tab-separated	files	 	(data	which	was	used	to	draw

charts)

If	there	are	more	documents	in	project	and	fit	window	appeared	after	fitting
first	spectra	or	fit	window	was	called	manually	from	parameters	grid,	you	may
switch	displaying	spectrum	fit	with	combo	box	at	toolbar.





See	also Parameters	Grid Bindings



Parameter	Status

Most	of	parameters	in	LT10	besides	of	value	has	a	status	used	to	control
parameter	value's	freedom	degree	in	calculations	process	and	range	of	binding	in
series	of	spectra.	Therefore	available	statuses	are	combinations	of	freedom
degree	specificators	and	range	of	binding	specificators.

Range	of	binding	specificators

Common
All	spectra	within	a	document	have	one	common	value.

Local
Each	spectrum	has	a	private	value.

Freedom	degree	specificators

Free
Parameter	value	is	free	to	change	in	calculations	process.

Fixed
Parameter	value	can	not	be	changed	by	minimalization	procedure.

There	are	four	standard	combinations	of	specyficators	mentioned	above	which
defines	statuses	available	to	choose:

Local	Free
Local	Fixed
Common	Free
Common	Fixed

Parameter	statuses	may	be	set	with	status	controllers	placed	at	the	top	of
parameters	grid	as	shown	in	picture	below.



note
It	is	possible	to	set	statuses	of	few	parameters	within	one	grid	at
the	same	time.	To	do	that	follow	this	steps:
1.	 select	controllers	which	statuses	you	want	to	change

(controller	is	selected	when	its	text	is	marked	white;	to	select
controllers	use	ctrl	key	or	simply	drag	cursor	through
controller	cells)

2.	 press	spacebar	to	activate	lastly	selected	controller
3.	 with	mouse	left	button	expand	active	controller
4.	 select	desired	status

All	selected	controllers	will	gain	status	chosen	for	the	last
controller	in	selection	range.

Beside	four	standard	statuses	there	are	two	additional	parameter	statuses	for
binded	parameters	(interdocument	parameter).

Binded	Free
Binded	Fixed

To	distinguish	parameter	status	on	parameters	grid,	each	status	has	binded
different	color.

note
Statuses	colors	may	be	adjusted	in	Options	dialog	(Paramters	grid
tab)	available	in	menu	Tools	->	Options.



See	also Parameter	Status Bindings



Parameters	Grid

Parameters	grid	is	a	tool	designed	to	edit	parameter	values	and	statuses	for
series	of	spectra	in	single	parameters	group.	Most	of	parameters	grids	have
similar	set	of	columns:	name	of	spectrum,	key	value	and	columns	holding
parameters	specific	for	actual	parameters	group.

Hiding	columns

Columns	in	parameters	grid	may	be	hidden	to	obtain	greater	clarity	of
situation	if	some	of	parameters	always	have	the	same	value	and	status	or	these
values	are	not	interesting	at	the	moment.	



To	hide/show	column	in	parameters	grid	deselect/select	items	in	grid's	context
menu	->	Visible	columns

note
Hiding	column	with	free	parameters	will	NOT	exclude	those
parameters	from	calculations!	To	exclude	parameter	from
calculations	set	its	status	to	Fixed	(any	of	following	are	possible:
Common	Fixed,	Local	Fixed	and	Binded	Fixed.	See	Parameter
Status)

Sorting	spectra

Spectrum,	Key	value	and	Model	columns	are	sortable.	(Model	column	is
displayed	when	parameters	grid	displays	spectra	from	more	than	one	document	-
see	Bindings)	To	sort	spectra	by	one	of	these	columns	simply	click	header	of	the



column	you	want	to	sort	by.

note
Sorting	one	parameters	grid	automatically	affects	other	parameter
grids,	holding	the	same	spectra.
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Project

Project	in	LT10	is	collection	of	documents.	LT10	allows	to	work	with	multiple
projects	as	if	they	were	documents	in	MDI	application.	Moreover	projects	may
run	their	calculations	simultaneously	without	necessarity	of	running	another
instances	of	whole	LT10	application.

note
User	has	to	be	cautious	in	running	big	number	of	calculations	since
each	project	runs	its	calculations	in	new	thread.	Multiple	threads
on	single-CPU	computers	may	affect	on	speed	of	the	calculations.

Project	window

Every	project	window	in	LT10	program	acts	like	document	in	MDI
Application	and	is	simply	collection	of	tab	pages.	Beside	of	tab	pages	which
contain	tracking	and	modifing	controls	there	are	additional	tab	pages	responsible
for	managing	parameters	of	each	document	in	project.

Project	properties	tab

Set	of	properties	specific	for	particular	project.

Initial	values
Defines	how	initial	parameter	values	for	spectra	in	series	are	obtained:
either	by	automatically	copying	values	from	previous	spectrum	in	series	or
using	those,	determined	in	previous	calculations.

Documents
Documents	present	in	project.	Both	spectra	series	and	theoretical	model	of
each	document	may	be	modified.

Bindings
Overview	of	all	bindings	defined	in	project.	Both	interdocument	parameters
and	shared	groups	are	displayed.



Search	tab

Search	tab	presents	actual	state	of	running	calculations.	The	tab	is	divided	into
three	parts

Events
Text	area	which	displays	information	about	such	events	in	calculation
process	as	changes	in	fit	variance,	time	when	calculations	finished	and	so
on.



Common	values
List	of	all	parameters	with	common	values	in	each	document	and	each
group	(Common	Free	and	Common	Fixed	statuses,	see	also:	parameter
status)

Local	values
This	group	box	contains	chart	which	presents	relationships	between	chosen
parameters	and	spectrum	index	in	series	currently	fitted.	If	there	are	any
parameters	with	local	values	(Local	Free	and	Local	Fixed	statuses)	those
parameters	are	available	to	choose	in	Parameter	combo	box.

note
Although	chart	is	good	view	of	changes	made	by	calculations
process,	user	is	allowed	to	switch	this	option	off	which	may
slightly	increase	calculations	speed.



Document	tab

This	tab	page	contains	another	tab	pages	control	which	holds	as	many
parameter	grids	as	many	parameter	groups	exist	in	chosen	theoretical	model.
Moreover,	parameter	names,	their	amount	and	properties	depends	on	model
binded	to	this	document.	Screenshot	of	such	document	is	presented	below
(binded	theoretical	model	is	multiexponential	model	used	to	positron	anihilation
spectroscopy	analysis).

As	shown	in	picture	document	tab	caption	is	equal	to	the	one	provided	while
creating	owning	project.

The	layout	of	each	page	in	document	is	similar.	The	top	part	of	page	is
occupied	by	grid	containing	parameters	for	each	spectrum.	Since	some	of	the
parameters	may	have	statuses	(a	combinations	of	range	specificatos:	common,
local	with	freedom	degree	specificators:	fixed,	free;	for	more	about	statuses	see
also:	parameter	status)	one	of	the	top	rows	in	grid	holds	controls	which	allows	to



change	those	statuses	for	chosen	parameters.	Each	spectrum	in	document	has
corresponding	row	with	parameters	which	belongs	to	the	just-displaying	group
tab	page.

note
Whereas	most	of	the	parameter	values	are	editable	in	parameters
grid	-	some	of	them	aren't.	For	example	in	groups	where
component	count	is	variable	-	value	of	first	intensity	(if	such
parameter	exist	in	the	group)	is	not	editable	and	is	changing	while
providing	values	of	intensities	for	other	components.	Value	of	this
intensity	adapts	to	other	intensities	to	make	sum	of	all	in	group
equal	to	100%.

Below	grid,	there	are	often	additional	group-specific	tools.	For	example	there
may	be	component	count	setter,	default	values	provider	or	other	handy	tools.



Theoretical	Model

Theoretical	model	is	a	definition	of	curve	which	is	fitted	to	the	experimental
data.	In	this	connection	it	have	an	influence	on	parameters	used	to	build	the
curve	(their	amount,	how	they	are	grouped,	and	whether	parameters	may
construct	components).

While	choosing	theoretical	model	in	Theoretical	Model	dialog,	parameters
defined	in	the	model	are	listed	in	bottom	group	box.	There	are	also	may	be	found
such	additional	informations	as	its	name,	description	and	path	to	the	assembly,
where	model	is	implemented.




